
 

 

   

 

 

My (New) Life With XP
 
TOM MARCELLUS 

WHEN the motherboard on our primary Marble 
Publications PC went south a few weeks ago, I went looking for a 
new top-quality Windows XP Professional machine. I’d put off 

upgrading the older Windows 98 PC to Windows 2000 or XP for a couple of 
reasons. First of all, I really didn’t want to install 2000 or XP on top of 
Windows 98 because of some of the horror stories I’d heard. If I was going to 
move up to one of these new O/S’s, I wanted a clean O/S install. Secondly, 
Windows 98 had run so reliably for us that I couldn’t see a deciding 
advantage in scrapping it. 

The most important thing about that older Windows 98 machine was 
that it ran Q&A for DOS like a dream, day in and day out, just as our earlier 
Win 98 machines had. This PC had at least a dozen copies of Q&A installed 
on it and a desktop fairly littered with Q&A icons. In addition to the copies 
of Q&A for testing and servicing clients, we kept all our Marble 
Publications applications in Q&A, including our Quick Answer subscribers 
database, billings and receivables databases, and so forth. Some of these 
applications involve big macros, External Programs and other features that 
help us get our Marble Pubs-related work done efficiently. So I was loath to 
move it all to another operating system and have to suffer through the usual 
move-related vagaries. 

Because most of the Q&A applications we deal with are in version 5.0 
(though we do use Q&A for DOS 4.0 and Q&A for Windows), we had to be 
absolutely certain that any new PC we purchased supported Expanded 
Memory.  We were temporarily operating on a backup Windows 98 PC and 
couldn’t afford any surprises with respect to the Expanded Memory issue. 
For this reason, we ordered our new PC from Jeff Noreman’s company, 
Nexus Unlimited (www.nexusunlimited.com). Another reason we bought from 
Jeff is that we knew he would be able to help us get any networking and 
Internet connection issues (which are vital to us for email and the Web-
related work we do) squared away quickly over the phone. 

Since the hard drive on the dead PC was fine, I had Jeff transplant it to 
the new machine as HARDDISK 2. The primary hard disk with the XP 
operating system on it would be a new 80GB, 7200 RPM Western Digital. 

After unpacking the new PC, I connected the monitor (a ViewSonic 19­
inch flat panel), the keyboard (an Avant Stellar 116-key, programmable 
model based on the wonderful old Northgate keyboard with the F Keys on 
the left where God intended them),  the Logitec wheel mouse, and our 
venerable LaserJet 2100M printer. I crossed my fingers and powered up. The 
machine booted in an a fraction of the time of our two-year-old Windows 98 
machine. I was already starting to like XP and the faster hard drive. I reckon 
that the astonishingly faster boot time is a combination of the two. 

After installing all of our Windows programs, some of which contain 
components that load on start-up, the new machine still booted in about a 
fourth of the time of the old one. But what amazed me even more was that I 
didn’t get one single dialog box about installing drivers for any of my 
peripherals. XP simply appeared to recognize everything connected to the 
computer and had the right drivers in stock. (I was probably just lucky.) 

I got the PC basically configured. I dumped the painfully garish XP 
color scheme in favor of “Windows Classic,” and made sure that the hard 
drive(s) wouldn’t be “put to sleep” during a lengthy phone call and crash 
an open copy of Q&A. Then I got Jeff on the phone and we spent 20 minutes 
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configuring my network, firewall and 
Internet connection. 

Q&A in the mix 
All of my Q&A installations were now 
on HARDDISK2. That drive, on the old 
machine, was partitioned into C: 
through G: drives, with the CD drive as 
drive H:. The new XP machine wanted 
to keep its CD drive as drive D:, so it 
bumped all the partitions on 
HARDDISK2 down by two. What was 
my drive D: on the old machine was 
now drive F:, what was on the old E: 
drive was now on G:, and so forth. I 
decided to live with this (for the most 
part) and not move all my Q&A 
installations (scattered about on these 
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Quick
TTTTTipipipipip 

Barcode Scanning in Q&A
 
Our local Society for the Blind asked 

me if it were possible to check off the 

returns from their monthly talking book audiotape mailout 

using a barcode reader. They send out 500 tapes and 

receive about 490 back. They wanted a way to find out who 

the miscreants are. 

I knew nothing about barcode readers, so I went out 

and bought one for $150. This one plugged into the USB 

port and Windows 98SE recognized it immediately. It’s easy 

to use. You point it at a barcode, press the little button and 

it goes beep! (Just like at the supermarket.) It dumps a 

numeric text string into your word processor or Q&A 

database field—whatever has the focus on your screen— 

followed by a carriage return. 

The carriage return is handy because it causes Q&A to 

exit the field. This action can execute an @Macro to run a 

macro with a pause in it. The user can enter some text, 

press the macro’s resume key, and be right where they 

need to be to scan the next one. 

I exported the client’s database to dBase format and 

used the telephone number as a unique identifying code to 

create a Code 39 barcode in the Avery Design Pro Lite label 

program. (The software is freely available from Avery’s Web 

site at www.avery.com ).  All the talking book audiotapes are 

sent out with reversible labels—on one side is the 

recipient’s label with the barcode, and on the reverse is the 

address of the Society. When the tapes are returned to the 

Society, the address cards are reversed and the barcodes 

are scanned into the Q&A database. 

The barcode macro I designed starts from a menu and 

pauses in the telephone field at the Retrieve Spec. On 

scanning the barcode, the telephone number code is 

inserted by the reader into the waiting field, followed by a 

carriage return.  Q&A finds the record and proceeds to the 

next field (the logging field) where programming inserts 

the system date, updates the record and returns to the 

menu. I have tried recursing this macro, but Q&A only 

allows five readings! To 

do this, you edit two 

identical macros and 

have each one call the 

other. But things can go 

wrong; it’s best to 

launch each reading 

separately. 

The barcode reader 

I purchased is a Phoenix 

80mm CCD USB unit. It’s 

made in Taiwan, and in 

the UK is available from 

Peninsula 

sales@peninsula­

group.com 

(www.peninsula­

group.com) but it must 

be available in the 

States as well, though 

perhaps under a 

different name. 

Roger Skidmore, 
rogerskid@supanet.com 

A client of ours has had 

similar success with a 

Metrologic Voyager Series 

hand scanner. They scan 

barcoded folder labels 

into a field to keep track 

of where the folders are. 

This unit connects to the 

PC through the keyboard. 

—Ed. 
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Quick Q&A Win Doesn’t Like Some Printers 
TTTTTipipipipip 

Beware if you are planning to buy a doesn’t have any problem with large drives and that repartitioning a 

new printer.  Q&A for Windows is not compatible with the large hard drive is not necessary. 

Lexmark E210 printer or the Samsung ML-1210 printer. 

By the way, I am convinced that Q&A for Windows John Dow, john@johntdow.com 
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the same quirks—some minor, some downright annoying. Life With XPcont’d from page 1 For example, I don’t get copy, cut and paste icons at 

back partitions.) to the same drives they were originally 
on. I knew I would have to update any path-related 
settings—Global Options, font file pointers stored in 
documents, macros, hard-coded paths in programming 
and the like—in most of my copies of Q&A. But I figured I 
could deal with this on an as-needed basis. 

That, as it turned out, was a mistake. I didn’t realize 
how XP would react to fonted Q&A reports. 

Incidentally, when you create a new XP desktop 
shortcut for Q&A DOS—this is case with Windows 2000 as 
well—you have to first point the shortcut to the copy of 
QA.COM you want. Once you’ve done that, you can then 
edit the shortcut and specify your Q&A startup batch file 
on the Program tab’s Command Line. 

I use Lesspace with all my copies of Q&A, so my 
startqa.bat batch file includes a line to load Lesspace, a 
line to start Q&A (using QA.COM, not QA1.EXE!), and 
finally a line to unload Lesspace when I quit Q&A: 

Lesspace
 
QA.COM
 
Lesspace \u
 

For each copy of Q&A DOS I have installed, I keep its 
startqa.bat file, along with Lesspace, right in that copy’s 
Q&A program files directory. This way, I don’t have to 
worry about paths in the batch file itself. All I have to 
make sure of is that each of my Q&A shortcuts points to 
the correct location of startqa.bat for the copy of Q&A that 
it runs. 

I noticed that the Memory tab in my Q&A shortcuts’ 
properties was pretty much the same as Windows 98— 
you select 1024 for both Expanded and Extended memory. 
Despite these settings, I wasn’t successful at getting XP to 
cough up any Extended Memory. But after several weeks 
of use I haven’t seen this cause any problems. The 3K of 
Extended Memory that Q&A 5.0 is thought to use for its 
own internal clipboard doesn’t appear to affect the 
clipboard even if Expanded Memory is reported by Q&A’s 
System Information screen (press Ctrl-F3 from the Main 
menu) as not being available. 

I always run Q&A for DOS in window mode (never 
full screen—yuck!). So I was tickled pink to discover that I 
could simply drop a copy of my 8514OEM.FON font file 
(that I’ve been using for years in Win 98) into my XP 
Windows/Fonts folder and have it show up as a 10 x 20 
font in my Q&A shortcut properties Fonts tab. This is by 
far the nicest looking Q&A DOS-in-a-window font you’ll 
ever lay eyes on. And it makes for what I consider to be an 
ideal window size. You can download the 8514OEM.FON 
font file from the Freebies page at www.quickanswer.com. 

Unpleasantries 
I am constrained to report that—at least in my case— 
Windows XP does not run Q&A for DOS as smoothly as 
my Windows 98 machines always have. You may notice 

the top of any Q&A for DOS window as I did in Windows 
98. I have to click on the little icon in the upper left corner 
of the window to get a drop-down menu and then select 
Edit followed by the operation (copy, cut or paste) I want 
to perform. So if I need to copy a block of text from one 
area of Q&A 4.0 to paste into another Q&A screen, I have 
go through this process twice. Windows 98 spoiled me. 

Something else I noticed straight off with Q&A for 
DOS—there’s a slight but maddening lag from the instant 
you hit a key to when the character appears on screen. I’ve 
tried a couple of different keyboards so far—even disabled 
all my startup programs—and can’t get rid of it. 

It’s worse when typing more than just a word or 
two—the display is always running behind. And it’s jerky. 
It looks like the keystrokes are being processed in batches 
instead of one at a time. When rapidly arrowing down a 
pick-list, it’s easy to blow right on past the item I want. If I 
tab through a form really fast, the cursor jerks around in 
fits and starts and looks like it’s skipping fields. To find 
out if it really was skipping fields, I made a little 51-field 
test database, naming the fields 1 through 50 and String. 
In all the numbered fields I placed this program: 

< String = String + 1
 

If I moved through this form as fast as I could press 
the Tab or Enter key (or simply held down one of these 
keys), the String field should, at the end, contain 50 if the 
programming in every field were executed. And indeed 
that turned out to be the case. (Phew!) It was only a 
perception that fields were being skipped. But still it’s 
something I never saw in Q&A for DOS running on a 
Windows 98 machine. I get the same keyboard lag at the 
command line, but not in any true Windows program. 

To be fair, a client of mine who runs Q&A 5.0 on a 
year-old Windows 2000 machine gets the same kind of 
keyboard lag, though it doesn’t seem to bother her. 

Another quirk. I have a billings database with an SE 
(Speedy/Existing) field. Whenever I add new record to it, 
I get a pop-up XUserselect list of the previous entries for 
this field. It saves me having to type in the client’s name. 
Never had a problem with this database in Windows 98— 
the pick-list would just be there. The same database 
running in XP, though—even after a Recover—sometimes 
hangs for 10 seconds or longer before the pick-list comes 
up. Q&A says it’s “Working…” What’s it working on? The 
database contains only 1,300 six-field records. At other 
times, the list just pops-up immediately as it always did in 
Windows 98. With a state-of the-art operating system, a 
processor so powerful that it requires its own personal 
cooling fan, and with more RAM than my PC of a few 
years ago had hard disk space, you’d think you’d get 
better and more consistence performance from anything 
that XP permitted to run in it. 

Continues  page 9 
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Sesame 
Seeds	 Using Sesame Tutorial 

Part1—Create an Application 
ERIKA YOXALL 

Recently, Erika Yoxall, a member of the Sesame development 
team, prepared a “Quick Start” tutorial guide designed to 
introduce beta testers to the first general Sesame beta release. 
(Until now, beta testing has been limited to a small select 
group of individuals close to Lantica Software.) Erika’s tutorials, 
which also include Design a New Application, Translate a Q&A 
Database, and Fixing Common Q&A Translation Issues, will be 
featured  here in The Quick Answer over the next few issues. 
We think you will find them of interest if you’re planning on 
(or just thinking about) migrating to Sesame. 

Note:—Due to the number of screen shots and relatively 
small amount of text (the pictures tell the story), we have 
departed from our usual format and kept all the screen 
shots in line with the tutorial text. Keep in mind that the 
screen shots have been scaled to fit within the confines of 
our two-column format. 

IN this tutorial, we will build a very basic Sesame 
Application, using Sesame Designer. We won’t be going 
into much detail at this point, but you will have a 

working Sesame application in no time flat! 

Step 1 – Starting Sesame Designer 
Start Sesame by clicking on the Sesame icon on your 
desktop. 

On the File menu, click New Application. 

Sesame Designer will open in a new window. 

Step 2 – Creating A New Application 
On the File menu in the Sesame Designer window, click 
New Application. 

You are asked to select a filename for your new 
application. Type c:\sesame\data\intro.dsr in the 
Filename box. (See next page.) Click Accept. 

4	 The Quick Answer ●  March 2003 



  

 

 

Sesame Designer creates the structure of a new 
application. By default, the application is named 
NewSesameApplication. 

Step 3 – Creating A New Database 
Creating a new database is as simple as adding a form. On 
the Design Menu Tree, click Forms to expand the Forms 
menu. Click Design A Form to expand the menu. Click 
Add New Database. 

Let’s add some fields to the database. Those of you 
who have used Q&A will recognize this technique right 
away. The white area on the right side of your screen is 
your form. Click on the form. Leave some space from the 
top and the left. A black cursor will appear on the form . 

Type Name. You will see the text appear on the Form. 

Now, to make a field, simply type a colon ( : ).  You 
will immediately see a text box labeled “Name” appear on 
the Form where you were typing. 

Sesame Designer opens a new Design Tab with a blank 
Form. 

Continues on page 8 
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@@@@@Help EDITED BY WILLIAM HALPERN 

Keeping Track of Report Printing Dates 
I have a question that might seem a little overboard. I use 
Q&A 5.0.There is something I need to do that would prevent 
problems and ensure the integrity of what I have to 
periodically report to our parent company. Our parent 
company has constantly changing requirements for special 
database printouts and reports.The format and basic 
content of the reports and the printouts are always the 
same, but the date ranges of the data they require always 
change.To make matters worse, they always want the 
reports to span the time from the date the last one was 
submitted through yesterday. I have resorted to keeping a 
paper calendar to remind me when I last printed the reports, 
and then redoing the Retrieve Spec for the new printing. Is 
there any way that Q&A can remember the last time I ran a 
particular report and then automatically run the next report 
starting from that date? A simple mistake on my paper 
calendar or a mistake in filling out the Retrieve Spec would 
give me incorrect data which could adversely impact our 
parent company’s decision making process. 

Perry 

This question offered a real challenge. Last month I wrote 
about some issues involved with date retrieves and 
inserting text files containing date values. Here we have a 
different issue. First, you would have to be able to create 
and save a record of the date you are running the required 
reports. Second, you’d have to be able to use that date to 
run the same process the next time the reports are 
required. And, lastly, you’d need a way to change that 
date at the end of any run so it would be correct for the 
start of the next run. One other little twist is that you want 
to run the process starting from the day before it was run 
last time until the day before it is run this time (in order to 
get a full day’s information at the start and end of the 
reports). Knowing today’s date is easy. But yesterday? 

Let’s start with a new but very simple one-field 
database named Now.dtf: 

Date Database
 
** Not for Data Entry **
 
** For System Use Only **
 

Yesterday< >
 

The programming in the Yesterday field would be: 

< If @Add then Yesterday = @Date - 1
 

This is a database that, when adding a new record, 
will auto-fill its sole field with Yesterday’s date. 

This gives you a reliable way for an automated 
procedure to find and capture yesterday’s date. With Q&A 
5.0’s built-in clipboard (F11 Copy / F12 Paste), Q&A can 
always be told to go get that date and use (paste) it 
wherever you specify. (In another database’s Retrieve 
Spec, for example.) Another feature of Q&A that you can 
put to use here is the ability to print via saved Print Specs 
or Reports either by printing with temporary changes, or 
by redesigning the Spec and then printing with permanent 
changes. Are you getting the picture yet? The first step is 
to redesign your reports so that they have an initial (first 
time run) date Retrieve Spec. You would create and save 
these designs without printing anything. 

All you’d need then is a way to automate the periodic 
report printing routine. And for this, macros are the way 
to go. 

The actual recording of the macros—along with the 
structure of your databases and reports—is up to you. But 
here are the general steps and sequences that need to be 
included when recording the macro: 

1. Print your reports by selecting Report / Print a Report 
with no temporary changes, and then escape back to the 
Q&A Main menu. 

2. Add a record to Now.dtf and copy the new date into the 
clipboard by having the macro press F11 from the 
Yesterday field. After this, have the macro press Esc and 
do not save the record. 

Send your Q&A questions to @Help, The Quick Answer, Marble 
Publications, Inc., 1927A Harbor Blvd, Costa Mesa, CA 92627 or email to 
mailbox@quickanswer.com.  Include your name, address, phone, and your 

Q&A version number (and whether DOS or Windows) and a detailed description of the problem. We’ll publish 
those questions we feel are of general reader interest; individual responses aren’t possible. 

Stumped? 
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3. Return to your reports in the Design/Redesign mode, and 
navigate to the date field. In the starting date field, have 
the macro paste in yesterday’s date (F12) and insert 
“>=” in front of that date (the ending date is always 
@Date - 1). Have the macro save the design but do not 
print the result. If the start and end dates are in the 
same field you can have your macro construct a 
Retrieve Spec like this: 

>={“F12 here”}..<{@Date}
 

This way, the reports you print will be current 
through yesterday. When they are done printing, have the 
macro set the date in Now.dtf to yesterday to be ready for 
the next automated printing (from today on). 

Starting MS Word From Q&A 5.0 
I’ve set up a fairly sophisticated application that makes use 
of the External Programs feature in Q&A 5.0. I use it to pass 
variables using the %F and %G parameters to start 
Microsoft Word and run a particular Word macro.This 
worked perfectly for me in Windows 98. Now that I’ve 
moved to Windows XP, my External Programs aren’t working 
anymore. Any suggestions? 

Cliff 

One issue here is that Windows XP will not accept 
external commands from a 16-bit command line (Q&A). 
You will get the dreaded NTVDM (NT Virtual DOS 
Machine) error. However, you can trick XP by starting the 
external program with a batch file rather than a straight 
command line running from the External Programs menu. 
There are some restrictions for the batch file run from this 
location. For example, you cannot use @echo off in the 
batch file, and you cannot enclose long command lines in 
quotes. Your batch file commands have to be structured 
along the following lines for a copy of Q&A running from 
the C:\ drive: 

CD\PROGRA~1
 
CD MICROS~2
 
CD OFFICE
 
Winword /M%1
 
CD\QA5
 
EXIT
 

A standard installation of Word will place the main 
Word executable (winword.exe) in the “Office” folder at 
the end of the following path. 

C:\Program Files

 |__ Microsoft Office


 |__Office
 

In your case, there was another “Microsoft” folder just 
above the “Microsoft Office” folder; thus the 
“MICROS~2” abbreviation is required for the batch file to 
refer to the second folder beginning with “Microsoft.” 

Your Q&A External Programs menu selection would be 
something like MSWORD, and the command line might 
look like this: 

WORDSTRT.BAT %F
 

Note that the batch file name is within the eight-
character (8.3) limitation for DOS programs. The multiple 
lines in the batch file for specifying the directory for Word 
have to do with the fact that XP, in a shell, seems to handle 
the command line differently from what you might be 
used to. The %1 in the batch file reads in, as an 
environmental variable, what you’ve passed to it as %F (a 
field value) from Q&A. In this case, that variable specifies 
the Word macro to run once Word has been started. Note 
that you also have to tell XP how to return to the Q&A 
directory after you’ve quit Word. 

You’re back in business. 

AAAAArrrrrchiving Dchiving Dchiving Dchiving Dchiving Daaaaatabase Rtabase Rtabase Rtabase Rtabase Recececececororororordsdsdsdsds 
I’m trying to archive all records from 2002 and earlier in our 
database. What is the best way to do this? If you can point 
me to a URL, I sure would appreciate it. 

Andy 

Terminology can be frightening because it can cause 
misunderstandings, which can then lead to data loss. By 
archive do you mean that you want to remove certain 
records from your main database and put them in an 
archive or historical database? Also, are you using Q&A 
4.0 or 5.0 for DOS? Lastly, do you already have a history 
database designed? 

(Andy replied Yes to the above questions and said he 
was using Q&A 5.0.) 

This being the case, the safe way to perform the 
archiving is to follow these steps. (Before you start, 
BACKUP your main or active database!): 

1. Create a Retrieve Spec in your main database that 
retrieves all the records from 2002 and earlier by typing 
the following in the applicable date field: < 01/01/2003 

2. Check to make sure that the records Q&A retrieves are 
in fact the ones you want to archive. 

3. Press F7 to return to the Retrieve Spec and make sure 
that the retrieve parameter from step 1 above is still 
there. 

4. Press Shift-F8 to save the Spec. Call it “Move to 
History.” 

5. From the Q&A Main menu, select File / Utility / Export / 

Continues on page 11 
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Note: You may need to click twice. The screen will flash Sesame Tutorial cont’d from page 5 briefly when it saves. 

Press Enter. The cursor moves to the line beneath the 
Name field. 

Type Address:. You should now have two fields lined 
up with each other. 

Add a few more fields using the same method. Press 
Enter. Type City:. Press Enter. Type State:. Press Enter. 
Type ZIP:. 

Save your design. The top Control Panel on the left 
side of your screen is called Commands. In the 
Commands Control Panel, click on Save Layout Design. 

Close the Design Tab by clicking Close Design Tab in 
the Commands Control Panel. This should return you to 
the Design Menu Tab. 

You’ve just created a Sesame application! Let’s take a 
look at it. On the Design Menu, click Application to 
expand the Application menu. Click Preview Application. 
A Preview window will open showing your new 
application. 

Concludes on page 12 

8 The Quick Answer ●  March 2003 



  

 
 

 

 

Life With XPcont’d from page 1 

Could I be having device, setup or configuration 
issues? Perhaps. It could be that all of these quirks are 
remediable. It could be that my XP machine is the only 
one in the world that exhibits this behavior. I’m pretty 
handy with Q&A and a handful of other programs. But 
I’m no hardware or O/S whiz. So if you know something I 
don’t about any of this, I’d be obliged to hear from you— 
and I will pass along anything constructive to readers. 

Notice that I’m not complaining about the speed at 
which Q&A runs in general in XP—Mass Updates, reports, 
big sorts and the like. I can’t say that I’ve done any 
stopwatch testing, but so far I’ve found nothing to rag 
about. On the other hand, I haven’t found anything to rave 
about, either. And that two-year-old Windows 98 PC was 
only half the machine this new one is. 

A Big Hairy Unpleasantry 
The only real showstoppers I encountered during the few 
weeks that I’ve been running Q&A in XP had to do with 
Q&A for Windows and a Q&A 5.0 report. 

We use Q&A for Windows here for a number of 
things, including merge-printing fancy documents with 
PostScript and TrueType fonts and graphics files. If you’ve 
seen one of our Quick Answer renewal notices, these are 
merge-printed in Q&A Win using the data we manage in 
our Q&A 5.0 subscribers database. 

I fully expected to get a Windows Illegal Operation 
error message when I started Q&A for Windows on the 
new XP machine—and I wasn’t disappointed. But a quick 
email to John Dow for his NTFIX patch solved that 
problem. Q&A for Windows now runs just fine. 

But there was a more serious matter. 
You’ve seen it repeated in these pages many times— 

when you copy or move a Q&A installation to a new 
location (a different drive or folder), it’s not just your 
Global Options, macros, and programming you have to 
review and update as necessary. Any area of Q&A where 
you can assign fonts must also be suspect. At a minimum, 
this includes any documents and labels you use regularly. 
If a merge database is connected to any such documents (in 
other words, it’s a merge document) or labels, you 
additionally have to check the bottom line of the Print 
Options screens of those documents and labels and update 
the paths to the merge files as necessary. 

If you use macros to automate mail merges, it’s even 
more critical that you investigate and update any aspects 
of those macros in terms of the files they deal with—any 
files that could cause a macro to bomb if the file is no 
longer where the macro expects it to be. I don’t need to 
dwell on the irreversible damage a rampaging macro can 
cause. For any macro that accesses a file and does 
something with it, you should print that macro out on a 
sheet of paper, and step through it manually (pressing the 
keys that the macro presses). This is the only way to know 

if a macro is safely runnable after you’ve moved or copied 
your Q&A files to a new location. 

Back to fonts. A simple macro that prints a fonted 
merge document can bomb after you’ve moved a Q&A 
installation to a new location. And not necessarily because 
of the location of the document itself. For a document to 
contain fonts (I’m not talking about regular text 
enhancements such as bold and underline), there will 
have to be a font file name specified in the Font 
Assignments screen in that document. (You  access the 
Font Assignments screen with Ctrl-F9.) The Font File Name 
at this screen will probably include a path to the font file, 
even if the font file resides in your main Q&A program 
files directory. When you move your copy of Q&A (along 
with your files) to a new drive and/or folder, those font 
file paths do not get automatically updated. 

Suppose you have a fonted document where the Font 
File Name at the Font Assignments Screen points to 
C:\QA\HPLASER4.FNT. You’ve purchased a new 
computer and had its hard drive partitioned to create a 
2GB E:\ drive where you plan to transplant all the Q&A 
files from your old PC. So you create a new E:\QA folder 
and copy (or install) all your Q&A program and font files 
there. You then create E:\QA\DATA and E:\QA\DOCS 
folders and copy all your databases and documents, 
respectively, to those new folders. 

What will happen when you try to open that old 
fonted document in the new copy of Q&A? You’re likely 
to get a “Disk drive door open…” or similar error message. 
(Yes, it’s a bug.) If you keep trying, you should eventually 
be able to open the document and correct the problem. 
What happened here is that the document tried to connect 
to a C:\QA\HPLASER4.FNT file that isn’t there. Q&A 
hands you the goofy error message. To correct the 
problem, you keep trying to blow past the Q&A error 
screen until the document opens. If and when it does— 
and I have never had this not succeed on a Windows 98 
machine—you thank your lucky stars and make a beeline 
for the Font Assignments screen, where you update the 
path to the font file and then resave the document. 

But the Font Assignments screen is available in other 
areas of Q&A as well. You can assign fonts in mailing 
labels, Reports and Print Specs, which brings me to this 
section’s subtitle. 

We have a Marble Publications Deposit Ticket report 
we’ve been using for years. When we receive checks for 
subscription renewals and the like, the transactions are 
entered into our TRANS.DTF database. Here we record 
the date, check number, amount, payer, and the item(s) 
purchased. When it’s time to make a bank deposit, we 
gather up the checks and run the Deposit Ticket report. It 
prints out a nice-looking (fonted) deposit ticket we hand 
to the teller along with the checks (so we don’t have to 
manually fill out a bank-supplied deposit ticket). 

About a week after we got the new XP machine, I had 
some checks to deposit and needed to run the report. Our 
Marble Publications copy of Q&A—along with all its 
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related files—was now on a different drive. I’d updated 
everything I could think of, but it slipped my mind that 
the report in question contained assigned fonts. When I 
went to the List of Reports screen for the TRANS database 
and selected the report, I got the Q&A “Drive door open…” 
error message. Repeatedly pressing the Enter to continue 
option accomplished nothing, but after hitting Esc a few 
times in an attempt to get the report open (as I was able to 
do with my fonted documents), I got a really nasty 
“NTVDM (NT Virtual DOS Machine)” error message with 
Close and Ignore options. Here’s one XP error message you 
never want to see: 

When I chose Ignore, XP blew Q&A clean out of the 
water. Shut it right down. Not so much as a fare-thee-well. 
(The Close option did nothing.) And I was able to 
duplicate this crude behavior on another fonted report. 

Fortunately, it didn’t appear to damage the TRANS 
database containing the report, but it did motivate me to 
check all my other important reports on the safer backup 
computer. I never saw a similar situation on a Windows 98 
machine elicit such a savage reaction. 

The problem now was that I couldn’t use the Deposit 
Ticket report because I couldn’t get into it to change the 
Font Assignments screen Font File path. What I did have 
to do was no cake walk: 

1. On the backup computer, make a copy of its TRANS 
database (naming it TRANSCOPY). 

2. Open TRANSCOPY’s Deposit Ticket report and make a 
note of the font file and fonts on the Font Assignments 
screen. 

3. Delete the Font File path and resave the report. 

4. Get the TRANSCOPY database over to the new XP 
machine. 

5. Open the TRANSCOPY Deposit Ticket report on the 
new PC, add the Font File path, reselect the fonts for 
Regular, Font 1, Font 2 and so forth and then resave the 
report without printing. 

6. Remove all the records from TRANSCOPY. 

7. Copy all the records from the existing XP machine’s 
TRANS database into TRANSCOPY. 

8. Verify that the records were copied correctly. 

9. Delete TRANS. 

10. Rename TRANSCOPY to TRANS. 

I didn’t make it to the bank on time. 
But what if I’d had, say, 20 such fonted reports in 

different databases? 
Worse yet. What if I hadn’t had a usable backup? 
I should mention that I didn’t have to re-font those 

sections of the report that were already fonted. All I had to 
do was fill out the Font Assignments screen. The fonted 
elements remained fonted (in the original fonts) even 
when no font file was attached to the report. 

My mistake was in not taking all of this into account 
in advance of moving to the new PC. But in Windows 98 I 
could have probably easily gotten into this report and 
updated the Font File path. Windows XP, in contrast, 
simply wouldn’t permit it. 

Parting shots 
There is much to like about Windows XP Pro. And if it’s 
zippier and breaks less and is better supported and runs 
today’s bloated programs faster and more reliably than 98, 
I’m all for it. 

But personally I don’t like it all that much more than 
98. I definitely don’t like the way Q&A for DOS behaves in 
it, compared to Q&A’s smooth and reliable operation in 
Windows 98. 

XP offers a “Compatability” tab in its shortcut 
properties. I tried all those options and they didn’t make a 
whit of difference. 

So far, I’ve managed to cause only one fatal XP crash 
(where I had no choice but to push the Reset button) and 
one near-fatal crash (where XP dangerously slowed to a 
crawl). Otherwise, I haven’t had to reboot the machine 
because of a system glitch. Over the same period of time 
on the old Windows 98 machine, I might have had to 
reboot for similar reasons perhaps three or four times a 
week. But interestingly enough, I don’t recall a Windows 
PC ever crashing while working in Q&A for DOS. 

After just a few weeks working with Q&A in XP, my 
advice can only be this: If you use Q&A for DOS heavily, 
particularly on healthy Windows 98 machines that are 
running well, you might be disappointed at how Q&A 
behaves in XP. 

If you are using Windows 95 or 98, do not upgrade 
those machines by installing XP on top of 95 or 98. If you 
simply must upgrade your existing machines to XP, and 
they have the guts to support it, I’d start from scratch if I 
were you. I’d backup everything that I wouldn’t be 
reinstalling from the original program CD’s, verify that 
my backups were restorable, then reformat the hard drive 
and do a clean XP install. 

Tom Marcellus is editor of The Quick Answer. 
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@Help...cont’d from page 7 

Standard ASCII. Select or type in the name of your main 
database, and then supply an ASCII filename like 
“archive.txt” for the output file. 

6. At the Retrieve Spec, press Alt-F8, select “Move to 
History,” and press F10 twice. 

7. At the blank Merge Spec, press F10. 

8. At the ASCII options screen, leave the default settings as 
they are and press F10. The selected records will be 
exported. Note that the records are not being removed 
from the main database at this time, only exported. 

9. If your history database is exactly the same design as the 
main database, import the archive.txt file into the 
history database using File / Utilities / Import / Standard 
ASCII. 

10.Check the history database to make sure that the 
records are there and that they imported properly with 
the data in the right fields. If so, then continue with the 
following steps. 

11. Back at the Q&A Main menu, select File / Remove / 
Selected Records from your main database. 

12. At the Retrieve Spec, press Alt-F8 and select “Move to 
History.” Press F10 twice and then answer YES. 

13. After the records have been removed from your main 
database, recover it to reclaim any excess space in the 
data file. 

This is the long way to go, but it’s the safest. 

RRRRRecececececommending Commending Commending Commending Commending Computomputomputomputomputers Rers Rers Rers Rers Reeeeevisitvisitvisitvisitvisitededededed 
When I spoke to you two weeks ago you said you were 
having no problems running Q&A 5.0 on Dell machines, 
specifically the 4500, and 4550’s. I’m looking at their 2350 
which is perfect for me. Does anyone have any input for me? 

Fred 

I have Q&A 5.0. It works just fine on my Windows 98 
machine. However, I recently purchased a Compaq Presario 
900 notebook with Windows XP Home Edition. When I try to 
load / install Q&A, I get a notice that there is insufficient 
memory and to close down one or more programs. There 
are no programs running. I have a 20G hard drive. Can you 
offer any help, or are there fixes available? 

Bill 

Normally, I won’t make specific recommendations 
regarding brand name machines, but since Fred and Bill 
asked about specific models, here is my take on them. 

Fred: I would have to say No; the Dell 2350 is not a good 
machine for you. It’s Dell’s entry level budget PC for 
home use. It has shared memory and an on-board video 
display card. This means that (1) you will sacrifice display 
quality and (2) you will not get the Expanded Memory 
Q&A 5.0 requires to run—the computer’s hardware will 
be using it. This model also has a built-in (on-board) 
network card. Our experience with these kinds of 
machines has not been encouraging. On the other hand, 
the Dell Dimension 4000 series systems, which do not 
have on board video cards or shared memory, are 
excellent machines and run Q&A just fine. Remember, 
though, that manufacturers sometimes change the 
hardware and/or firmware configurations they use in 
their PCs in the middle of production runs. So two PCs 
with the same model number that appear identical in all 
respects could have different innards. Therefore, you must 
always carefully check the equipment specifications of the 
PC you are about to purchase before putting your money 
down. 

Bill: If you bought the Compaq Presario 906, it has, 
according to Compaq: “ATI Radeon IGP Integrated 
Graphics with 16MB shared video memory.” If this is the 
case, you will probably not be able to get the Expanded 
Memory that Q&A 5.0 needs to run properly. We have 
always cautioned people that before buying a new 
computer they should make sure that it does not have 
shared memory and that it is physically capable of 
providing Expanded Memory. That being said, you can 
try installing Q&A by running “install/d” from your 
floppies. You will also then have to go to our Web site and 
download and install the Datepatch, Speedfix, and Lesspace 
utilities before you will be able to try to run Q&A on the 
new machine. But do keep in mind that if your hardware 
cannot deliver Expanded Memory to Q&A, you will have 
problems with merge documents, labels, and printing in 
general. It will also affect the ability of Q&A to perform 
searches on large databases. 

DDDDDisappisappisappisappisappearearearearearing Ring Ring Ring Ring Recececececororororordsdsdsdsds 
Recently, we upgraded to computers using Windows XP 
Professional.We purchased The Q&A/New PC Setup Guide 
from Marble Publications and configured the machines 
accordingly.The only problem I am having is when I finish a 
record and go to “Print” and try to retrieve the record I just 
completed, Q&A gives me a “No Records Were Found…” 
message. Using Search/Update, on the other hand, finds the 
record. The only way I can retrieve the record in “Print” is by 
exiting Q&A and restarting it. Q&A can then find the record 
or any other record in the database the first time, but then 
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not, the damage is probably more serious. Let me know@Help...cont’d from page 10 and we’ll take it from there. 

fails to find it on subsequent consecutive tries. I have 
records in other databases that Q&A finds and prints 
without a problem. 

Phil 

These symptoms indicate that you may have damage in 
that particular database. (All the others work fine.) You 
are using the File / Print Retrieve Spec to find these 
records. Here’s what I recommend you do: 

1. Make a copy (backup) of the database in question. 

2. Use the File / Design / Customize / Speed Up Searches Spec 
to remove any speedy (index) fields in the database. 
Make a note of the Speedy fields and the codes (S, SU, 
SE) they contain. 

3. Mass Update (File / Mass Update) all the records in the 
database by pressing F10 at the blank Retrieve Spec and 
F10 again at the blank Update Spec. 

4. Copy the design of the database to a new name. (File / 
Copy / Copy Design Only.) 

5. Copy all the records from your active database to the 
new database. (File / Copy / Copy Selected Records.) 

6. Replace the Speedy field codes at the Speed-Up Spec. 

I bet that the database will now function properly. If 

TTTTTo Po Po Po Po Pararararartition or Ltition or Ltition or Ltition or Ltition or Lesspacesspacesspacesspacesspaceeeee 
I received the new Q&A installation CD today. Thanks. I got 
an unexpected phone call from another computer 
consultant. One of my former employees had contacted him 
for support last fall. I told him I was going to use Lesspace 
with Q&A and he didn’t think it was a good idea. He 
recommended partitioning the hard drive instead. I still 
have Partition Magic 8.0 and have no problem installing it 
on the computers if that’s the better way to go. Would I be 
better off partitioning or using Lesspace? 

Tom 

We (and all our clients) run Q&A for DOS with 
Lesspace. It’s actually better protection than small (less 
than 2G) partitions because a user can always point Q&A 
to a file located on a non-partitioned drive. IT consultants 
and I always have this argument. Some of them are ultra­
conservative and always favor a hardware solution over a 
software solution. The answer is: either way is fine. You 
will not create problems with either option. Lesspace is 
easier and less intrusive than partitioning, and affords 
better overall protection against problems that could arise 
from users pointing Q&A to files on different drives 
(including database, document, temporary and 
configuration files)—and even upgrades to servers and 
workstations. It’s the option I would recommend. 

Bill Halpern is co-owner of Professional Computer Technology Associates 
(PCTA) in Newtown, Pennsylvania and is President and CEO of Lantica 
Software, LLC. 215-598-8440. bill@pcta-usa.com, www.pcta-usa.com. 

Sesame Tutorial cont’d from page 8 

The Application, Database and Form have all been 
given default names. Click on the NewForm with the 
green dot next to it under Add Data. There is your form, 
ready to add records! 

That’s all it takes to create a new Sesame application! 

Erika Yoxall is the technical coordinator for Lantica Software, LLC. 
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